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Preface

Scope of Manual

This manual describes the RedHawk Architect™, an easy-to-use GUI interface for
creating and maintaining a runtime and development environment for a single board
computer (SBC).

Structure of Manual

This manual consists of:

® Chapter 1, which introduces you to RedHawk Architect and guides you
through its use.

¢ Chapter 2, which explains Importing ISO Images to avoid repetetive
manual optical media insertion.

® An Index containing an alphabetical reference to key terms and concepts
and the pages where they occur in the text.

Syntax Notation

The following notation is used throughout this manual:

italic Books, reference cards, and items that the user must specify appear in
italic type. Special terms may also appear in italic.

list bold User input appears in 1ist bold type and must be entered exactly
as shown. Names of directories, files, commands, options and man
page references also appear in 1ist bold type.

list Operating system and program output such as prompts, messages and
listings of files and programs appears in 1ist type.

[] Brackets enclose command options and arguments that are optional.
You do not type the brackets if you choose to specify these options or
arguments.

hypertext links When viewing this document online, clicking on chapter, section,

figure, table and page number references will display the
corresponding text. Clicking on Internet URLs provided in blue type
will launch your web browser and display the web site. Clicking on
publication names and numbers in red type will display the
corresponding manual PDF, if accessible.
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Related Publications

The following table lists Concurrent documentation for RedHawk Architect and the
components that can be installed using RedHawk Architect. Depending upon the
document, they are available online on RedHawk Linux systems or from Concurrent’s
documentation web site at http://redhawk.ccur.com/docs.

RedHawk Architect Pub. Number
RedHawk Architect Release Notes 0898600
RedHawk Architect User’s Guide 0898601
RedHawk Linux

RedHawk Linux Release Notes 0898003
RedHawk Linux User’s Guide 0898004
RedHawk Linux Cluster Manager User’s Guide 0898016
RedHawk Linux FAQ N/A
NightStar RT Development Tools

NightView User’s Guide 0898395
NightTrace User’s Guide 0898398
NightProbe User’s Guide 0898465
NightTune User’s Guide 0898515
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1
Using RedHawk Architect

This chapter introduces you to RedHawk Architect and provides instructions for its use.

Introducing Architect

RedHawk Architect is an easy-to-use GUI interface for configuring, building and flashing
embedded solutions.

RedHawk Architect greatly simplifies the following tasks to create and maintain a runtime
and development environment for single board computers (SBCs):

* installing custom configurations of the Red Hat® Enterprise Linux
distribution

* installing and configuring the RedHawk™ operating system

¢ installing SBC-specific board support packages (BSPs)

* installing NightStar™ RT application development tools

® maintaining and reconfiguring an SBC’s root file system

¢ deploying root file system images onto target systems

With Architect, you choose the Linux and application modules that will be installed with
the RedHawk kernel. For example, select networking, web server, web browser, database,
X server, minimal or all packages. Architect allows the Linux file system to be customized
and minimized for embedded applications using flash memories as small as 2 GB.

Architect creates and processes a configuration file based upon your selections and
performs actual RPM package installations. It prompts you to insert the necessary
RedHawk, Red Hat, and NightStar RT media depending upon the features selected.

Creating aroot File System for Target Systems

To create a target file-system image that can be used on a single board computer, use
RedHawk Architect on a supported host system to perform the following steps:

1. Create a target file-system image by selecting the software to be installed
and building the image.

2. Configure the image.
3. Customize the image for your embedded application.

4. Deploy the image on your target boards.
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These procedures are described in the sections that follow. The steps may be repeated to
change the image and/or deploy it any number of times.

Running Architect

1-2

For instructions for installing RedHawk Architect, refer to the RedHawk Architect Release
Notes.

Architect must be run as the root user.
To run Architect, type architect at a shell prompt:
# architect

Note that the sudo (8) command can alternatively be used to run Architect if that
method is preferred to using a root shell.

The very first time Architect is invoked after it is installed, a dialog appears presenting you
with the Architect End User License Agreement.

End-User License x

RedHawk Architect 6.0

Please read the following End-User License Agreement and click the Accept
button if you agree to the terms.

CONCURRENT END-USER LICENSE AGREEMENT ﬁ
SOFTWARE PRODUCTS: 7

Open Source Components: RedHawk Linux Operating System, RedHawk Cluster
Manager, RedHawk High-Performance Math Package, RedHawk Global File System,
RedHawk High Availability NFS, RedHawk Frequency Based Scheduler (FBS), RedHawk
Target Licenses and all related doecumentation.

Concurrent Proprietary Components: MightStar LX, NightStar BT, SIMulation

Workbench, Laboratory Workbench, RedHawk Architect, MAXAda For RedHawk,

MAXAda AXl For RedHawk, FORTRAN 77 For RedHawk, RedHawk Linux Systems Exerciser,

RedHawk VME-To-PCl Support Library, RedHawk /O Device Drivers and all related @

[eccot ] ot |

Figure 1-1 Architect End User License Agreement

When Architect starts, a dialog appears presenting you with the option to start a new
session or load an existing session.
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RedHawk Architect 6.0

Before you begin, please indicate a
session to work with. “ou may start a
new session or open an existing
session.

Create a new session.

Open an existing session.

Cancel Close this dialog and choose a session later.

Figure 1-2 Opening RedHawk Architect Dialog

To start a new session, click on the New button. See “Creating a New Session” on page
1-4 for details.

A session can be saved at any time and loaded later to continue work on the file system
image. To edit an existing session, click on the Open button. See “Editing an Existing
Session” on page 1-43 for details.

When the Cancel button is clicked, the RedHawk Architect main window
appears, as shown in the following figure.

RedHawk Architect - 0 x
File . Edit Tools Help

J = L 'J y @9 Estimated Image Size: [ ][ I%]

4y Select Software

l Red Hat Packages l

[ RedHewk l

l ¥ NightStar RT l

Select New Session or Open Session to get started.

Configure Image

Build Image

Customize Image

Deploy Image

Figure 1-3 RedHawk Architect Main Window

1-3
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Your choices are:

® start a new session by clicking on the New Session icon or selecting
New Session from the File menu along the top of the window. See
“Creating a New Session” on page 1-4 for details.

® edit an existing session by clicking on the Open Session icon /= or
selecting Open Session in the File menu. See “Editing an Existing
Session” on page 1-43 for details.

Creating a New Session

An Architect session describes all decisions made about a particular target file-system
image, including:

® the target SBC

¢ which software should be installed

® how the software should be configured

When you select the New button from the opening Architect dialog, or the New Session
icon or New Session from the File menu along the top of the RedHawk
Architect main window, the New Session dialog, shown below, displays.

Please choose a RedHawk OS release and a target board type for the new
session.

RedHawk Release: |RedHawk 6.0

Target Board: [None (create generic session) |v

[ Cancel H oK i

Figure 1-4 New Session Dialog

This dialog enables you to define the target board and its various characteristics using the
fields described below.

1-4
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RedHawk Release

Specify the version of RedHawk to be used for creating the target file-
system image. Be sure that you have the correct version of the RedHawk
and Red Hat Enterprise Linux media or ISO files necessary to create a
target file-system image of the specified RedHawk release.

Target Board

Specify the target board from the dropdown. Select NONne to build a
generic target file-system image that does not target any particular board.

I/0 Expansion

This section shows I/0 expansion connectors that are available on the
board you have selected. For each I/O expansion connector, you may
designate an expansion module that you may have connected to it. The
choices available depend on the board you have selected.

Selecting Software to Install in the Image

To select the software to install in the file system image, click on Select Products
from the toolbox on the left side of the RedHawk Architect main window. This
allows you to select software from the following three groups:

¢ Red Hat Enterprise Linux packages
¢ RedHawk Linux operating system

® NightStar RT tools
Some initial selections are made for you by default; e.g. the core RedHawk OS.

The Estimated Image Size gauge at the top of the RedHawk Architect
main window indicates the approximate size the file system image will be when built. It
also indicates the percentage of the target board’s root device that will be consumed by the
image.

Once an image is built, you may click on the Refresh Image Size button to
calculate the actual image size as it is stored on disk. Alternatively, you may select
Refresh Image Size from the TOOIs menu. The Estimated Image Size
gauge will be updated to reflect the current actual size.

The spin control box to the right of the Estimnated Image Size gauge may be used
to change the desired maximum size of the image. This value cannot exceed the known
size of the root device but it can be made smaller. If the size of the root device is unknown
the maximum value allowed is 1 terabyte.

Selecting Red Hat Packages

To select Red Hat Enterprise Linux packages for the file system image, click on the Red
Hat Packages selection from the Select Products toolbox.

1-5
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Red Hat packages may be navigated by way of several “Package Views”. Select the
desired package view from the Package Views dropdown. The following views are
available and are described in the subsections that follow.

® Red Hat Package Groups

¢ All Packages

¢ Selected Packages

Using the Red Hat Package Groups View

The Red Hat Package Groups view provides a view of Red Hat packages
organized in a hierarchy of groups. The package group hierachy is the standard Red Hat
package group hierachy. This view is shown in the following figure.

Packages may be selected or deselected by choosing a package group in the upper pane
and then checking or un-checking packages in that group in the lower pane. All packages
may be selected with the Select all packages in group button.

The UNAO button cancels out your last select or unselect operation.

File Edit Tools Help

a0

*untitled - RedHawk Architect

Estimated Image Size: 1524.6 MB (76% of 2.0 GB)

| [2.06B

B

4l Select Software

\.% Red Hat Packages

~Select Base Distribution Packages to Install

Red Hat Enterprise Linux 6

Package View: | Red Hat Package Groups ﬂ

' NightStar RT

=, Configure Image A
% | Build Image ™
Customize Image ™,

Databases ‘ System Management ‘ Virtualization | Desktops ]i‘__ég_p_!ig@_t_\p]j_lg__,I Development ‘1 4

Group Name Description

The GNU Emacs extensible, customizable, text editor.

Graphics Creation Tools Software for creation and manipulation of still images.

Internet Applications Email, chat, and video cenferencing software.
Internet Browser Firefox web browser
Office Suite and Productivity A full-purpose office suite, and other productivity tools.

TeX support Support for the TeX document formatting system.

&

11213

E emacs-23.1-21.el6.x86_64 GMNU Emacs text editor

" emacs-auctex-11.85-10.el6.noarch 1313 Enhanced TeX modes for Emacs

O
D emacs-gnuplot-4.2.6-2.el6.x86_64 524

emacs-nox-23.1-21.el6.x86_64 10434 GMNU Emacs text editor without X support

& Deploy Image ",

[ _+ Select all packages In gmup]
Install | Name | size(ks) | Description
D ctags-etags-5.8-2.e6.x86_64 18 Exuberant Ctags for emacs tag format

Emacs bindings for the gnuplot main application

Figure 1-5 Selecting Red Hat Packages, Red Hat Package Groups View

Using the All Packages View

The All Packages view, as shown in the following figure, provides a sorted linear list
of all Red Hat packages.
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*untitled - RedHawk Architect - o x

File Edit Tools Help

4 3 O Q) cstmate image sie: TP [Er——

—Select Base Distribution Packages to Install

74l Select Software

Red Hat Enterprise Linux 6 Package Vien:
[ - Select all packagesl [ 4 Undo l Show only packages matching: :]
Install | Name I Size(KB) | Description H

) NightStar RT D 389-ds-base-1.2.8.2-1.el6.x86_64 4228 389 Directory Server (base)
D 389-ds-base-libs-1.2.8.2-1.el6.i686 986 Core libraries for 389 Directory Server
D 389-ds-base-libs-1.2.8.2-1.el6.x86_64 1045 Core libraries for 389 Directory Server
o & Consolekit-0.4.1-3.el6.x86_64 268 System daemon for tracking users, sessions a
E ) ConsoleKit-libs-0.4.1-3.el6.x86_64 22 ConsoleKit libraries
D ConsoleKit-x11-0.4.1-3.el6.x86_64 43 X11l-requiring add-ons for ConsoleKit
I:‘ DeviceKit-power-014-1.el6.i686 241 Power Management Service
D DeviceKit-power-014-1.el6.x86_64 246 Power Management Service
] ElectricFence-2.2.2-28.l6.1686 55 A debugger which detects memory allecation
D ElectricFence-2.2.2-28.el6.xB6_64 63 A debugger which detects memory allocation
[l Gconf2-2.28.0-6.€16.1686 6021 A process-transparent configuration system
=4, Configure Image ™,
E GConf2-2.28.0-6.el6.x86_64 6076 A process-transparent configuration system
& | Build Image ™,
—\; D GConf2-devel-2.28.0-6.el6./686 787 Headers and libraries for GConf development E
Customize Image
[ | C1D]

# Deploy Image AN

Figure 1-6 Selecting Red Hat Packages, All Packages View

Packages may be selected or deselected from this list. The Show only packages
matching box allows you to search for packages by name.

All packages can be selected by clicking on the Select all packages button.

The UNdO button cancels out your last select or unselect operation.
Using the Selected Packages View

The Selected Packages view, as shown in the following figure, provides a sorted
linear list of all Red Hat packages that are currently selected for installation.

1-7
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File Edit Tools Help

Select Base Distribution Packages to Install

*untitled - RedHawk Architect

2 3 @R cmueimoe s (T I |20

B

-

74l Select Software
Red Hat Enterprise Linux 6 Package View: Selected Packages -
\\? Red Hat Packages
[%] Hide required packages Show only packages matching: :}
‘ RedHawk
‘ Install I Name Size(KB) Description
)1 MightStar RT [ consoleKit-0.4.1-3.e16.x86_64 268 System daemon for tracking users, sessi...
E ConsoleKit-libs-0.4.1-3.el6.x86_64 22 ConsoleKit libraries
E GConf2-2.28.0-6.el6.x86_64 6076 A process-transparent configuration syst...
E ORBIt2-2.14.17-3.1.el6.x86_64 594 A high-performance CORBA Object Regu...
]
E alsa-lib-1.0.21-3.el6.x86_64 1187 The Advanced Linux Sound Architecture...
B atk-1.28.0-2.el6.x86_64 933 | Interfaces for accessibility support
B avahi-libs-0.6.25-11.el6.x86_64 114 | Libraries for avahi run-time use
4 caire-1.8.8-3.1.€16.x86_64 797 A 2D graphics library
E cups-libs-1.4.2-39.el6.x86_64 665 Common Unix Printing System - libraries
E dbus-1.2.24-4.el6_0.x86_64 482 D-BUS message bus
E desktop-file-utils-0.15-9.el6.x86_64 143 | Utilities for manipulating .desktop files
-, Configure Image ™
E eggdbus-0.6-3.el16.x86_64 321 Experimental D-Bus bindings for GObject
& | Build Image i
B emacs-23.1-21.el6.x86_64 11213 GNU Emacs text editor
Customize Image .
kA emars-ramman-23.1-21 216 x26 R4 ANAAR Fmars commaon files
Deploy Image N,

Figure 1-7 Selecting Red Hat Packages, Selected Packages View

Packages may be deselected from this list. The Show only packages
mMatching box allows you to search for packages by name.

To include the required packages in the list, check the Hide required packages
checkbox. When this box is unchecked, only the optional packages are shown.

The UNdO button cancels out your last select or unselect operation.

Selecting RedHawk OS Options

To select RedHawk Linux OS and kernels for the file system image, click on the
RedHawk selection from the Select Products toolbox. The RedHawk page,
shown in the following figure, displays.
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*untitled - RedHawk Architect - o x
Fle Edit Tools Help

F4 2 Y €9 @  estimated Image Size: | [20c8 =

~Select RedHawk Products to Install

RedHawk Linux OS 6.0

4 Select Software

\-:;‘3 Red Hat Packages

s. RedHawk

) NightStar RT

RedHawk Kernels to Install
["] standard kernel

[E] Trace kernel

["] Debug kernel

Options
{D Install kernel debugging features

-, Configure Image ™
| Build Image S
Customize Image ™,

About RedHawlk

A

Figure 1-8 Selecting RedHawk Options

Select which RedHawk kernel(s) to install by checking the appropriate checkbox(es):
Standard, Trace and/or Debug. The standard kernel does not have tracing or
debugging capabilities and it is the smallest sized kernel option. The trace kernel does
offer tracing capabilities but it does not have debugging capabilities. The debug kernel
offers both debugging and tracing capabilities. Note that at least one kernel must be
selected; the GUI enforces this by ensuring that a sole remaining selection cannot be
deselected.

Select Install kernel debugging features to install extra support for live
kernel debugging. This option is also required for RedHawk to be able to create crash
dumps. See the RedHawk User’ s Guide for more information.

Selecting NightStar RT Options

To select NightStar RT tools for the image, click on the NightStar RT selection from
the Select Products toolbox. The NightStar RT page, shown in the following figure,
displays.

1-9
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*untitled - RedHawk Architect - o x
File Edit Tools Help
4 3 Y @ @ estimated mage size: 2068 5
7 Select Software Select NightStar Tools to Install
NightStar RT
\.:f Red Hat Packages
[] Install NightStar tools
X
kj

Customize Image

=4, Configure Image
BN 5 o ey
% | Build Image . E

NightView NightProbe NightTune About NightStar

A

Figure 1-9 Selecting NightStar RT Tools

Click on the Install NightStar tools check box to indicate that NightStar RT
software is to be installed in the image. Once selected, you are presented with various
NightStar Installation Options that you can choose from.

Click on the Install all NightStar clients and servers radio button to indicate
that all NightStar RT servers and clients are to be installed in the image.

Click on the Install select NightStar servers only radio button to indicate that
only NightStar RT servers should be installed in the image. You may select individual
servers from the list by clicking on the checkboxes for each tool.

Click on the About NightStar button to see a detailed description of each of the
individual NightStar tools that are available for installation.

Configuring an Image

1-10

It is possible to configure a target file-system image before or after the image has been
built by selecting Configure Image from the toolbox on the left side of the
RedHawk Architect main window. This selection is available before and after an
image is built, however note that there are additional APPIY buttons present on the pages
after an image has been built. It is necessary to apply any changes made after the image
has been built in order for the changes to be reflected in the on-disk file-system image.
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To configure the file system image, select Configure Image from the toolbox on the
left side of the RedHawk Architect main window. This allows you to configure the
following four groups:

¢ General Settings
* Console
® Networking

® File Systems

Some initial selections are made for you by default.

Configuring General Settings

To configure time zone, root password and default system run level for the file system
image, click on General Settings from the Configure Image toolbox. The
General Settings configuration page appears, as shown in the following figure.

*untitled - RedHawk Architect - o x

File Edit Tools Help
=] hj Hjj 6 G@ Estimated Image Size: 1524.6 MB (76% of 2.0 GB) |2 GB E]

—Configure General Settings

4l Select Software

“, Confi !
., Configure Image hN -

[Americamew York [~]

L
_E!H' General Settings

[%| Hardware clock is set to UTC

~Root Password
Pacsor
~Run-level
System Run-level:
k

% | Build Image ™,
Customize Image ™

Deploy Image

Figure 1-10 General Settings Configuration Page

In the Time Zone section, select the proper time zone for your location from the
dropdown. Click in the checkbox to indicate if your system clock uses UTC.

1-11
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NOTE

If you select the Hardware clock is set to UTC check-
box, be sure to set the target system’s BIOS clock in Coordinated
Universal Time. If you do not select this, set the BIOS clock
according to the selected time zone.

In the ROOt Password section, enter the root password in the Password field.
Reenter it in the Confirm Password field.

NOTE

The default root password is redhawk (all lowercase letters and
only one word with no spaces).

In the Run Level section, select the desired default run level from the dropdown.
If a change is made to this page after the target file-system image has been built, it is

necessary to click on the Apply General Settings... button to apply the settings to
the image. This button will not appear before the image has been built.

Configuring a Console

To configure a serial console for the file system image, click on Console from the
Configure Image toolbox. The Console Configuration page appears, as
shown in the following figure.

1-12
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*untitled - RedHawk Architect -0 x

File Edit Tools Help

4 3 3 € @ estimated image size: (2068 B

~Cenfigure Consol

4 Select Software

“, Configure Image ™
!
_E General Settings k

O Configure a serial console

|!} Console

@ Networking

/77 File Systems

II

% | Build Image b
Customize Image B

Figure 1-11 Console Configuration Page

Click on the Configure a serial console checkbox to activate the fields that
define the port and baud rate for the console.

Select a port from the Serial Port dropdown.
Select a baud rate from the Baud Rate dropdown.

If a change is made to this page after the target file-system image has been built, it is
necessary to click on the Apply Console Settings... button to apply the settings to
the image. This button will not appear before the image has been built.

Configuring Networking

To configure networking for the file system image, click on Networking from the
Configure Image toolbox. The Network Configuration page appears, as
shown in the following figure.
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*untitled - RedHawk Architect - O x
File Edit Tools Help
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~Configure Networking

4] Select Software

 Network Devices
<4, Configure Image -,

Device|Enabled | IP Address Netmask
l !aisenerm Settings 10.134.30.123 255.255.255.0
ethl | No DHCP DHCP
l | console l eth2 | No DHCP DHCP
eth3 | No DHCP DHCP
ethd | No DHCP DHCP
@ Networking eths | No DHCP DHCP E
ethh No NHCP NHCP
l [\ File Systems l
—~Hostnam
() Use DHCP hestname k

® Use static hostname: [redhawk

Miscellaneous Settings

() Use DHCP settings Default Gateway: [10,134,30,195 ]
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® Use static setti
@ Usesiatic seiNGS | pNs servers:  [10.134.30.195 10.75.24.6 |

% | Build Image .,
Customize Image h
4 Deploy Image ™,

Figure 1-12 Network Configuration Page

All available network devices are listed in the Network Devices section.

To configure a particular network device, click on the device to select it, then click on the
Edit button. The Configure Network Device dialog shown in the following
figure displays.
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Configure Network Device

HEI ethl (unknown)

[éj [] Enable on boot
k

IP Address Configuration

® Dynamic IP Configuration (DHCP)

() Manual Configuration

| Fox ]| X cancel|

Figure 1-13 Configure Network Device Dialog

The selected network device is displayed at the top of the dialog.

Click on the Enable On Boot checkbox to enable/disable the device automatically on
boot.

Select Dynamic or Manual address configuration by clicking on the appropriate
radio button. For manual configurations, enter the IP address and netmask in the
appropriate fields.

Click on OK to apply the settings to the image and close the dialog. Click Cancel to
cancel changes.

On the Network Configuration dialog under the Network Settings
checkbox, either check the Use DHCP checkbox or supply the hostname, default
gateway, domains, and DNS server addresses in the appropriate fields. Note that multiple
DNS domains and DNS servers may be specified by separating multiple entries with either
spaces or commas. Be sure to check the Us€ DHCP checkbox if a DHCP server will be
providing the network parameters dynamically.

If a change is made to this page after the target file-system image has been built, it is
necessary to click on the Apply Settings button to apply the settings to the image.
This button will not appear before the image has been built.

Configuring File Systems

To configure file system options for the file system image, click on File Systems from
the Configure Image toolbox. The File System Configuration page
appears, as shown in the following figure.
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Root File System Options
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Figure 1-14 File System Configuration Page

There are two different partitioning modes supported: Simple Disk Partitioning
and Advanced Disk Partitioning. By default this page is in the simple disk
partitioning mode.

Simple Disk Partitioning

1-16

Simple disk partitioning is the traditional partitioning that was offered by previous
versions of RedHawk Architect. In this mode only a single partition will be created on the
specified root device.

Indicate the desired root device in the ROOt Device field.

Check the Mount read-only box to mount the root file system read-only. If the root
device is a flash device, this will help preserve the life of the device.

Check the Mount with *noatime” option box to mount the root file system with
the noatime option. This helps to minimize the number of writes to the root device when
root is not mounted read-only.

Check the Mount resources listed in /etc/rwtab in tmpfs box to mount
the files and directories listed in /etc/rwtab as writable but temporary files in a tmpfs
file system. This is required to make a read-only root file system work. If root is not
mounted read-only, this option is still useful to help minimize the number of writes to the
root device.
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If a change is made to this page after the target file-system image has been built, it is
necessary to click on the Apply Settings button to apply the settings to the image.
This button will not appear before the image has been built.

Advanced Disk Partitioning

The advanced disk partition mode provides a more modern and flexible disk partitioning
scheme. In this mode multiple partitions and even multiple disks can be defined and
configured.

The Advanced Disk Partitioning mode is shown in the following figure.

*untitled - RedHawk Architect - O x
File Edit Tools Help
4 3 O 6 estmotet image sie: R TTICITEY o) (EE—
£l Select Software ~Configure File Systems
[ T () Simple Disk Partitionin:
-, Configure Image P 9

® Advanced Disk Partitioning

L
5{ General Settings

Disk Partition Size (MB) Mount Point File System Options
‘_E'C‘mm‘e sdal 4096 ! ext2 noatime
sda2 maximum /data extd defaults

Networking

" Flle Systems

4 Add Partition] = Remove Partition |-, Edit Partition 4 Reset to Defaults

|4 Add Disk| | == Remove Disk| &

Install boot-loader on disk:

... If the size of any disk device is exceeded, you will get an error when the
“ device is installed.

% | Build Image "
Customize Image AN
Deploy Image -,

Press Add Partition to add new partitions to the currently selected disk.
Press Remove Partition to remove the currently selected partition.
Press EAit Partition to edit attributes of the currently selected partition.
Press Add Disk to add a new disk to the set of currently available disks.

Press Remove Disk to remove the currently selected disk from the set of available
disks.

Use the Install boot-loader on disk pulldown to choose the disk that you will be
booting from if multiple disks have been defined.
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NOTE

You must ensure that any additional disks defined using advanced
partitioning in fact exist on the target for installation to succeed.

NOTE

Multiple disks cannot be partitioned with the Flash Image
deployment tool. In order to use multiple disks you must deploy
with one of the Installer methods (via DVD or via USB).

Building an Image

To build the file system image by installing the selected software, select Build Image
from the toolbox on the left side of the RedHawk Architect main window. The
Build Image page shown in the following figure displays.

*untitled - RedHawk Architect - o x
File Edit Tools Help
(4 (3 6y @ @ estmated image size: | [20Ge B

Al Select Software [~ Build Imag

“4, Configure Image A " .
- Use this page to build the target system image.
% | Build Image ™
Build Options.

&:f Bulkl Target Directory: l,’var,'hblarchltectnmages ]

Image Name: [test ]

[%] Use imported 150 images instead of media 4 Import ISO Images...

a Build Image...

Customize Image A
Deploy Image .

Figure 1-15 Build Image Page
Choose a directory in which to build the file system image and enter it in the Target

Directory field, or click on the Browse button to display a file browser from which to
choose.
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NOTE

Do not use /tmp as the target directory. Packages like “tmp-
watch” might remove files that have not been accessed in a certain
number of days, thereby sabotaging the image directory.

Choose a name for the file system image and enter it in the Image Name field.

NOTE

Make sure that the directory you specify has enough free disk
space to hold one or more file system images, each of which can
be several gigabytes in size.

Click on the Build button to begin the build process. The rest of this section assumes that
you have not previously imported the ISOs from their respective media by clicking on the
Import ISO Images button or selecting Import ISO Images in the Tools
menu. Advanced users may wish to do that to avoid inserting DVD or CD media
repeatedly. See “Chapter 2: Importing ISO Images” for more information.

Dialogs are presented to guide you through the process of installing the software into the
image. For example, you will be prompted to insert various DVD or CD media, as shown
in the following figure. Follow the directions to load the media, then click OK to begin.

\p Please insert the RHEL 6.0 Update (Version 6.0) DVD.

[ [ men |

Figure 1-16 Build Prompt to Insert Red Hat Media

When OK is selected, the Red Hat installation begins. The Build Image screen
overlays the RedHawk Architect main window and tracks the progress, as shown
in the following figure.

Clicking Abort at any time in the build process aborts the build. A confirmation
message then displays and you must click on the ClOS€ button to close the message box
and reactivate the RedHawk Architect main window.
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3 Image Builder X

Building image (/var/lib/architect/images/test).

— Current Progress

Installing Red Hat Enterprise Linux 6 packages:

113111 1o

file-libs-5.04-6.el6

—Overall Progress

View:

Fetched Red Hat Enterprise Linux packages.

[ & ok ][ Abort ]

Figure 1-17 Status of Red Hat Installation

A progress bar at the top of the Build Image screen shows the progress of the Red Hat
installation from the media.

A status area in the lower half of the screen tracks the progress of the complete build
process. The status area can be changed to show an error log using the View dropdown.
View

When Status is selected, the overall progress messages are displayed.
When Error Log is selected, the error log is displayed, which shows any
error messages generated by the build process. Regardless of the View
setting, critical error messages result in pop-up error dialogs with which
you can interact.

Abort

Click on this button to abort the build. A confirmation dialog displays
allowing you to confirm or decline aborting the build process.

OK

Once the build is completed or aborted, click on the OK button to close the
Build Image screen and reactivate the RedHawk Architect

main window.
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When the Red Hat installation is complete, the dialog shown in the following figure
appears.

\::l,) Please insert the RedHawk Linux OS5 (Version 6.0) DVD.

aoxé[ Abort |

Figure 1-18 Build Prompt to Insert RedHawk Media
Load the RedHawk Linux media, then click OK. The RedHawk installation begins and

the Build Image screen tracks the progress, as shown in the following figure.

b | Image Builder X

Building image (/var/lib/architect/images/test).

—Current Progress

Installing RedHawk Linux 05 6.0:

Installing : ccur-memexact-5.1.1-20110623.x86_64 10,24 [3
Installing : ccur-redhawk-release-6.0-20110623.noarch 11/24
Installing : ccur-redhawk-setup-6.0-20110623.noarch 12/24
Installing @ ccur-ptp-1.0.0-1.20110623.x86_64 13/24
Installing : ccur-vmlinux-trace-6.0-20110623.x86_64 14/24
Installing : ccur-vmlinux-kdump-6.0-20110623.x86_64 15/24
Installing : ccur-firmware-myrilog-1.1-1.20110623.x86_64 16,24
Installing @ ccur-vmlinux-debug-6.0-20110623.x86_64 17/24
Installing : ccur-pam-capability-6.0-20110623.x86_64 18/24
Installing : ccur-vmlinux-6.0-20110623.x86_64 19,24
Installing : ccur-kernel-6.0-20110623.x86_64 20/24 -

— Overall Progress

Fetched Red Hat Enterprise Linux packages.
Installed Red Hat Enterprise Linux packages.

| ok || aport |

Figure 1-19 Status of RedHawk Installation

When the RedHawk installation is complete, the dialog shown in the following figure
appears.

\:]i) Please insert the NightStar BT (Version 4.2 or newer) CD.

Figure 1-20 Build Prompt to Insert NightStar RT Media

1-21



RedHawk Architect User’s Guide

Load the NightStar RT media, then click OK to begin. The NightStar RT installation
begins and the Build Imnage screen tracks the progress, as shown in the following
figure.

3 Image Builder x

Building image (/var/lib/architect/images/test).

— Current Progress

Installing NightStar RT Server == 4.2:

ccur-nstar x86_64 1.4-5.1 ccur-nstar-rt-server-cd-4.2 96 k [=]
ccur-ntracelog x86 64 7.2-1.3.2 ccur-nstar-rt-server-cd-4.2 668 k
ccur-ntunecommon x*86 64 3.4-1.1 ccur-nstar-rt-server-cd-4.2 4.4 k
ccur-ntuneserv %86 64 3.4-1.1 ccur-nstar-rt-server-cd-4.2 928 k

Transaction Summary

Install 7 Packagel(s)

Upgrade 5 Package(s)

Total download size: 2.8 M k -

—Overall Progress

Fetched Red Hat Enterprise Linux packages.
Installed Red Hat Enterprise Linux packages.
Installed RedHawk Linux OS5,

| doc || avor |

Figure 1-21 Status of NightStar RT Installation

When all software is installed, the completion message shown in the following figure
appears.
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Image Builder x

The image has been built.

— Overall Progress

Installed Red Hat Enterprise Linux packages.

Installed RedHawk Linux 0S.

Installed NightStar RT Server.

Configuration changes have been applied to the image.
Done.

L

Show Output Log

Figure 1-22 Build Completed Successfully Message

Click OK in the Build Image screen to close it and reactivate the RedHawk
Architect main window.

Customizing an Image

To further customize the file system image, select Customize Image from the
toolbox on the left side of the RedHawk Architect main window. This allows you
to customize the following groups:

Software Updates
Kernel Manager
Additional RPMs
File Manager
Chroot Shell

Image Cleanup

Each of these customizations will be fully described in the following sections.
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Software Updates

To install RedHawk and NightStar updates into the file system image, click on
Software Updates in the Customize Image toolbox. The Software
Updates page appears, as shown in the following figure.

*untitled - RedHawk Architect - O x
File Edit Tools Help
4 3 4 @ @ estimoted mage size: T TTYCIPFXYs5) 2068 B

—Software Updates

4 Select Software

<4, Configure Image ™. . .
- Use this page to install RedHawk and NightStar updates in the target system image. To install
S Bldlimage AN updates you must have a Concurrent Software Updates for RedHawk CD, DVD, or 150 image.
y Visit the Concurrent Software Portal to download an 150 image with the latest updates.
! Customize Image B

http:/fredhawk.ccur.comjupdates/home.html
@ Software Updates

& Kernel Manager

| |
| |
I 3 Additonal ReMs l
| |
| |
| |

[%| Use imported 150 images instead of media _J Import 150 Images...

F.Ipdate Options

g

Install Updates.

= F
File Manager

@ Chroot Shell
S Image Cleanup

4 Deploy Image .

Figure 1-23 Software Updates Page
Press the INnstall Updates... button to install updates and you will be prompted for to

insert the media. Follow the instructions as they are presented. You should see the
following dialog displayed once all updates have been successfully installed.
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Updating image (/var/lib/architect/images/test).

—Current Progress

The image has been updated.

—Overall Progress

Installed Software Updates for RedHawk Systems.
Done.

Show Output Log

Figure 1-24 Software Updater Dialog

Kernel Manager

To customize kernel settings for the file system image, click on Kernel Manager
from the Customize Image toolbox. The Kernel Manager page appears, as
shown in the following figure.
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Configure Custom
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Figure 1-25 Kernel Manager Page

The Kernel Manager allows you to perform different functions with the kernel
configuration in the target image.

The Kernel to BOOT area allows you to choose which installed kernel should be the
default kernel that boots in the target image. Any change made to this setting is
customized in the target image immediately.

The Configure Custom Kernel area contains functions related to configuring
custom kernels for the target image. The Compile Custom Kernel area contains
functions related to building custom kernels for the target image. These functions will be
described in the following sections.

Note that only one custom kernel configuration, and therefore one custom kernel, can be
associated with a specific target image at any given time.

Kernel

The Configure Custom Kernel button begins the process of creating a custom
kernel configuration. The custom kernel configuration is based upon the kernel
configuration that is selected in the dropdown menu that is immediately to the right of the
Configure Custom Kernel button.

The choices in the dropdown are: RedHawk standard kernel, RedHawk
tfrace kernel, RedHawk debug kernel and Custom kernel (available
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once a custom kernel configuration has been imported or configured). The first three
create new configurations based on the configurations of the standard RedHawk kernels.

The Custom kernel choice bases the new configuration on the current custom kernel
configuration that is associated with the image; thus, the Custom kernel choice can
be used to further customize a configuration that you have already customized or
imported.

Pressing the Configure Custom Kernel button will bring up two different dialog
windows. The first dialog window displays overall configuration progress status, as shown
in the following figure.

Custom Kernel Manager *

Configuring custom kernel in image.

—Current Progress

Running ccur-config

Configuring version: 2.6.36.4-RedHawk-6.0-custom
Backing up existing .config to .config.bak
Cleaning source tree, ..

—Overall Progress

k View:

Started custom kernel configuration process.
Using "standard” configuration as base.

[ & ok H Abort ]

Figure 1-26 Custom Kernel Dialog

This window shows the status of running the ccur-config command in the target
image kernel source directory. The ccur-config command will eventually bring up the
Linux Kernel Configuration window to customize the kernel, as shown in the
following figure.
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Figure 1-27 Linux Kernel Configuration Dialog

This window allows you to customize almost any aspect of the custom kernel
configuration. It is expected that users who are performing this step have a thorough
understanding of Linux kernel configuration.

Note that you must SAVE the kernel configuration before you exit the Linux Kernel
Configuration window. Failure to SAVe the configuration will result in an error
being displayed in the Custom Kernel Manager dialog window and no changes to
the custom kernel configuration will be made.

NOTE

Certain compilation related RPMs must be installed on the host
system in order to successfully configure and build a custom ker-
nel (e.g. make, gce). If any of these RPMs are missing you will
be presented with a dialog detailing which RPMs must first be
installed on the host system before you can proceed.

Import Kernel Configuration
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The Import Kernel Configuration button allows you to choose a configuration
file on the host system and import it to become the custom kernel configuration in the
target image.

Note that once a custom kernel configuration has been imported you can further customize
it by using the Configure Custom Kernel button and selecting the Custom
kernel to base the configuration on.
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Export Kernel Configuration

The Export Kernel Configuration button allows you to copy the target image’s
current custom kernel configuration to the host system.

Build Custom Kernel

The Build Custom Kernel button allows you to build a complete and installed
custom kernel in the target image. You must first have created a custom kernel
configuration, either by using the Configure Custom Kernel button or by using
the Import Kernel Configuration button.

Building a custom kernel compiles each file that comprises the Linux kernel and this
process can take quite a bit of time to complete. Once you start the process, you will see
the Custom Kernel Manager dialog appear, as shown in the following figure and
it will describe the entire process.

Custom Kernel Manager x

Building custom kernel in image.

—Current Progress

Running ccur-config

Configuring version: 2.6.36.4-RedHawk-6.8-custom
Backing up existing .config to .config.bak
Cleaning source tree. ..

Preparing configuration for a custom kernel...

—Overall Progress

View:

Started custom kernel build process.

[ & oK ][ Abort

Figure 1-28 Initial Build Progress

Initially ccur-config will be invoked and once that completes the kernel build stages
will begin, as shown in the following figure.
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Custom Kernel Manager x

Building custom kernel in image.

—Current Progress

Running make bzlmage

ccC arch/x86/vdso/vvar.o [=]
cC security/selinux/xfrm.o

LDs arch/x86/vdso/vdso32/vdso32. lds

AS arch/x86/vdso/vdso32/note. o

AS arch/x86/vdso/vdso32/int80.0

AS arch/x86/vdso/vdso32/syscall.o

AS arch/x86/vdso/vdso32/sysenter.o

CC mm/rmap.o

cC arch/x86/vdso/vdso32-setup.o

cC fs/futimes.o

cc arch/x86/mm/extable.o *

—Owerall Progress

k View:

Started custom kernel build process.
Completed ccur-config.

[ & ok H Abort ]

Figure 1-29 Kernel Build Stages
Finally, once the entire build and install process is complete, the kernel source tree will be

cleaned to free up the temporary space used to build the kernel. At this point the entire
build process will be complete, as shown in the following figure.
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Custom Kernel Manager x

Building custom kernel in image.

—Current Progress

The custom kernel has been built.

—Overall Progress

Completed make modules. B
Completed make modules_install INSTALL_MOD_STRIP=1.

Completed make install. |:|
Completed make distclean.

Completed custom kernel build process.

Done.

Show Output Log

Figure 1-30 Kernel Build Complete

The custom kernel automatically becomes the default kernel to boot. If this choice is not
desired, change the kernel to boot using the Kernel To BOOT area as described above.

Remove Custom Kernel

The Remove Custom Kernel button allows you to remove the current custom
kernel from the target image. This will remove the entry in grub.conf as well as all of
the associated kernel files in the image.

Note that the custom kernel configuration itself is not removed. Thus, it is still possible to
build a custom kernel based on the current custom kernel configuration that still remains
in the target image.

Additional RPMs

To install additional RPMs into the target file system image manually, click on
Additional RPMs from the Customize Image toolbox. The Install
Additional RPMs page appears, as shown in the following figure.
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Figure 1-31 Install Additional RPMs Page

The Install Additional RPMSs page can be used to locate RPM files on the host
system and then easily install them into the target file system image. Note that the
interface supports multiple selection; if you have a set of RPMs that have dependencies
upon each other you will need to select all of the RPMs simultaneously to have them
properly installed together into the target file system image.

Installing Board Support Packages

File Manager
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Concurrent provides Board Support Packages (BSPs) for several supported SBCs. These
BSPs are distributed as RPMs that may be installed in an image using the Additional
RPMs page as described above. Contact Concurrent (Support@ccur.com or 1-800-245-
6453) for information on how to obtain BSPs for a particular SBC.

To copy various files into the target file system image manually, click on File
Manager from the Customize Image toolbox. The File Manager page
appears, as shown in the following figure.
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Use the File Manager to manage files and directories in the target system image. To copy files
from the host file system to the image: select the target directory in the image, then select files
on the host and press Copy. To delete selected files, right click on the mouse for the delete

option.
Host: » @ © Image:/ o @
= bin = bin
icamputer ™ data 9 boot
77 root B doc B dev
= ; 9 emacs  etc
architect & grub & home
= images = lib
5 iso 9 lib6a
= media 9 media
= mfg B mnt
= net B opt
B src i proc
9 root
1 sbin
9 selinux
9 srv
9 sys
B tmp
9 usr
= var

File name: || = Copy

Figure 1-32 File Manager Page

The File Manager page supports many features including multiple selection, the
ability to create new directories in the target file system image, and the ability to delete
files in the target system image.

To customize the target file system image manually, click on the Chroot Shell from
the Customize Image toolbox. The Chroot Shell page appears, as shown in the

following figure
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*untitled - RedHawk Architect - o x
File Edit Tools Help

4 (P 8 extmorea mage size: (IETTETTYTOPFRTS |ET——

—Chroot Shell

4 Select Software

-, Configure Image “, _ _ _

The Chroot Shell is an interactive bash shell where you may run commands to further customize the
. Build Image . target system image. The root directory of the shell will be in the target system image.
/7 Customize Image All changes made to the file system from the shell will be applied to the target system image only.

@ Software Updates

Run Chroot Shell in: | GNOME Terminal |+

& Kernel Manager

2 Additional RPMs
v

@ Chroot Shell
S Image Cleanup

| |
| |
| |
T
| |
| |

4 Deploy Image N

Figure 1-33 Chroot Shell Page

From this toolbox you can open a “chroot” shell in a terminal window. Select the type of
terminal from the dropdown and click on the Run chroot shell button. A terminal
screen opens, as shown in the following figure.

E Chroot Shell N
File Edit View Search Terminal Help

Entering image configuration shell. |
Exit the shell when you are finished.

image:test (redhawk)# [ N

Figure 1-34 chroot Shell
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This provides a shell with the root directory being the file system image directory. All
changes made to system files (including software installed or removed) will be done in the
file system image directory only. The host’s root file system will not be affected.

Exit the shell when changes are complete.

You may reduce the size of the file system image by removing various types of files that
may be unnecessary for the image. To remove unnecessary files from the image, click on
Image Cleanup in the Customize Image toolbox. The Image Cleanup
page appears, as shown in the following figure.

*untitled - RedHawk Architect - 0O x

File Edit Tools Help

P L™ 10553 MB (7% or 2.0

| [2.0ce E

4 Select Software Flmage Cleanup

@ Chroot Shell
8 Image Cleanup

“, Configure Image Y
Use this page to remove unneeded resources from the target system image.
# | Build Image ™,
/! Customize Image ™ —Remove select files ~Remove RPM database
Select the types of files to remove This will remove the RPM database from the
from the target system image: target system image.
@- Software Updates
[] Man Pages
l Ny, KernelVansger ] |Gl it WARNING: Once this is done you will
|| Locale Archive not be able to add or remove RPMs in
the target system image.
3 additional RPMs ["] README, /usr/share/doc etc.
-
=
[ File Manager ]
é:; Remove Files & Remove RPM Database

4 Deploy Image .,

Figure 1-35 Image Cleanup Page

Select the types of files to remove from the file system image and click the Remove
Files button.

To remove the RPM database from the file system click the Remove RPM
database button. Once this is done you will lose all ability to manage RPMs in the
image. This cannot be undone. Only do this once you are sure you do not have to add or
update any more RPMs in the image.
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Deploying an Image

Target root file system images can be deployed onto target boards in several differnt ways
with RedHawk Architect .

¢ USB devices can be directly flashed with the root file system image. This
includes USB drives and also CompactFlash cards in CompactFlash-to-
USB adapters. These devices can then be inserted into a target board and
the board will boot the image upon a restart. See “Flash Image” on page
1-36 for more information.

* DVD media installers can be created with the root file system image on it.
Architect creates a bootable installation DVD that will boot on the target
and install the root file system onto the target board’s local media. Once
complete, the DVD is removed and the board will boot the image upon a
restart. See “Install via DVD media” on page 1-40 for more information.

®* A USB drive installer can be created with the root file system on it.
Architect creates a bootable installation USB drive that will boot on the
target and install the root file system onto the target board’s local media.
Once complete, the USB drive is removed and the board will boot the
image upon a restart. See “Install via USB drive” on page 1-41 for more
information.

¢ (ClusterManger can deploy the root file system image over the network. It
can deploy an installer that will install the root file system image onto the
target board’s local media, or it can deploy the root file system image via
NFS for fully diskless booting. See “Using Cluster Manager to Deploy an
Architect Image” on page 1-42 for more information on using
ClusterManager.

Flash Image

To copy a target root file system image to a CompactFlash device, select Deploy
Image from the toolbox on the left side of the RedHawk Architect main
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window. This will display the Deploy Image USB Device page, as shown in the
following figure.

*untitled - RedHawk Architect -0 x
File Edit Tools Help

F4 [ 6y € @ estimated image size: ([ LN ) cR) | 2008 =

Install Image to USB Devic:

4 Select Software

“4 Configure Image ™, . . . .
Use this page to install the target system image on a USB device connected to this host. That device can
Build Image then be used to boot the target system.
- uild Image
p To install on a CompactFlash card, you may use a CompactFlash USE adapter.
[+ Customize Image
4 Deploy Image B

— USB Device

N
'Q DVD Installer

|| USB Installer

Figure 1-36 Deploy Image USB Device Page

The Install Image... button allows you to copy a root file system image onto a USB
device (e.g. a standard USB Drive or a CompactFlash that is connected directly to the host
machine via a USB-to-CompactFlash adapter). Note that IDE/SATA CompactFlash
adapters are not supported at this time.

NOTE

CompactFlash devices and USB drives can be bought inexpen-
sively at many retail stores that sell computer accessories. Note
that the duration of the flashing process depends upon the perfor-
mance rating of the specific CompactFlash device or USB drive. It
is recommended to use CompactFlash devices or USB drives that
have a minimum of a 40MB/s read/write performance rating.

Pressing the INstall Image... button will begin copying the target root file system onto
the USB device by bringing up the USB Device Flasher dialog, as shown in the
following figure.
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(] USB Device Flasher x

Flashing image to USB device.

—Current Progress

This space intentionally left blank.

—Overall Progress

e

Figure 1-37 Flash Image Dialog

The host system will now be scanned for attached CompactFlash devices. If multiple
devices are found a choice will be presented to the user, otherwise the sole device found
will be selected by default. Once a device is found or chosen, the following confirmation
dialog will appear:

usB De\;r.ice Flas.l'.ler x

| '«

Flashing image to USB device.

—Current Progress

Locating USE devices.

[SSESRSESESRERSE AR RR R R RS R RT]

® Architect Warning x
Using device /dev/sdb (USB_2.0 Flash_Drive).

The contents of this device will be destroyed!

~Overall Progress

View: |Status |~/

[ Fox || apor _

Figure 1-38 Flash Device Confirmation

Press OK to confirm the operation and then the copy will begin, as shown in Figure 1-39.

1-38



RedHawk Architect User’s Guide

® USB Device Flasher x

Flashing image to USB device.

—Current Progress

Copying image to /dev/sdb:

TREN] 1%

—Overall Progress

View: |Status

Using device /dev/sdb (USB_2.0 Flash_Drive).
Initialized partition table on /dev/sdb.
Created file systems on /dev/sdb.

e

Figure 1-39 Flash Copy Begins

Note that no initial check is made to determine whether the image will fit onto the size of
the selected CompactFlash device. If the copy fails because of insufficient space, an error
message will be displayed, as shown in the following figure.

UsSB Deu.rice Flasﬁer x

|

Flashing image to USB device.

—Current Progress

Copying image to /dev/sdb:

IETETRENI 20%

Architect Error

Q Could not copy image to /dev/sdb

~Overall Progress

View: |Status | =

Initialized partition table on /dev/sdb.

|
|
Using device /dev/sdb (USB 2.0 Flash_Drive).
Created file systems on /dev/sdb.

| ~ Jox | [ abort |

Figure 1-40 Flash Dialog Error

If the CompactFlash is large enough to hold the image, and no other error occurs during
the copy, a success dialog will be presented, as shown in Figure 1-41.
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(] USB Device Flasher x

Flashing image to USB device.

—Current Progress

The image has been flashed to a USB device.

—Overall Progress

Initialized partition table on /dev/sdc. (]
Created file systems on /dev/sdc.
Copied image to /dev/sdc. |:|

Installed grub bootloader on /dev/sdc.
You may now safely remove the USB device from the system. E
Done.

Figure 1-41 Flash Copy Completed

Once the copy has completed successfully the CompactFlash can then be placed onto the
intended target board and the board can be reset to boot into a fresh RedHawk installation.

Install via DVD media

1-40
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RedHawk Architect main window. This will display the Make Installation
DVD page, as shown in the following figure.

*untitled - RedHawk Architect - O x
File Edit Tools Help
i 3 &Y €9 @ estimated image Size: 1324.8 MB (66% of 2.{JeL)] | [z0cB £
. —Make Installation DVD
£ Select Software
“4 Configure Image ™,
Use this page to create a bootable DVD that can be used to install the image on the target system.
Build Image ™, The disk devices used by the installation on the target system are those specified on the Configure
E i g File Systems page.
/7 Customize Image "
& Deploy Image ® Make installation DVD
) Just make IS0 file for installation DVD
O Burn IS0 file to DVD
I E USB Device l
-
-
I U DVD Installer l Device: [)‘dew‘srtl |v] Speed: | Maximum Possible | v
= [] Format DVD
I || USB Installer l [ Automatically install image to disk when DVD is booted

Figure 1-42 Make Installation DVD Page

Choose Make installation DVD to directly burn a DVD that will install the target
root file system image onto DVD media. No ISO file will be saved on disk in this mode.

Choose Just make ISO file for installation DVD to create an ISO file that
contains an installer image. This ISO file can be later burned to DVD, or it may be useful
with other tools or for long term storage.

Choose Burn ISO file 10 DVD to burn a previously created ISO file to DVD media.

Install via USB drive

To create an bootable USB drive that will install the target root file system image into a
target system, select USB Installer from the toolbox on the left side of the RedHawk
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Architect main window. This will display the Make Installation USB Stick
page, as shown in the following figure.

*untitled - RedHawk Architect - o x
File Edit Tools Help
4 1 B €9 @ estimated image Size: 1324.8 MB (66% of 2.8J1]] | [20ce B
e T ~Make Installation USB Stick
4 Select Software
=4, Configure Image RS
Use this page to create a bootable USB stick that can be used to install the image on the target
Build Image " system. The disk devices used by the installation on the target system are those specified on the
B . = Configure File Systems page.
[ Customize Image ™
o || Automatically install image to disk when USB stick Is booted
# Deploy Image %

e USB Device " || Make USB Stick...

L/' DVD Installer

|| USEInstaller

Figure 1-43 Make Installation USB Stick Page

Press the Make USB Stick... button to write a bootable installer image to an attached
USB drive.

Choose Automatically install image to disk when USB stick is
booted to create a USB stick that will install the target root file system image onto a
target board’s local media without any prompting or user interaction.

NOTE

This will destroy any data on the target system’s local media
whenever booted into a target system and therefore this should be
used carefully; however, it is useful on systems without an
attached console display or configured and connected serial con-
sole.

Using Cluster Manager to Deploy an Architect Image

RedHawk Linux Cluster Manager provides Architect users with additional methods of
deploying file system images. With Cluster Manager, images may be remotely installed
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directly to disk devices on target systems, or target systems may be booted diskless from
an Architect image.

NOTE

Using Cluster Manager is only possible when the host machine
and target device are connected via networking, and the target
device fully supports the Preboot eXecution Environment (PXE)
standard.

Using Cluster Manager to diskless-boot Architect images is especially useful during
development of an embedded application and the file system image. Test systems may be
quickly booted to test each iteration of the file system image. When diskless booting an
Architect image, the image remains in-place where it was built and configured by
Architect. Various services are configured by Cluster Manager to allow target systems to
diskless-boot the image. Multiple target systems may diskless-boot the same image
simultaneously.

To begin using Cluster Manager with Architect images, install Cluster Manager as
described in the RedHawk Linux Cluster Manager User’s Guide, then run the cm-
import command to import an Architect image into Cluster Manager.

Consult the RedHawk Linux Cluster Manager Evaluation User’s Guide for details on
installing or diskless-booting images.

Editing an Existing Session

A session can be saved at any time and loaded later to continue work on a file system
image.

To save the current session click on the Save Session icon [ or on Save Session in
the File menu. Selecting SQve Session As in the File menu displays a file selection
dialog and allows you to save the current session using a different name.

To make a copy of the current session click on the Duplicate Session icon % or on
Duplicate Session in the File menu. Duplicating a session makes a copy of the
current session and optionally copies an existing image to go with it.

To load an existing session, click on the Open Session icon /¥ or on Open Session
in the File menu. You may also click on the Open button from the opening dialog when
Architect first starts.
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2
Importing 1ISO Images

This chapter describes how to create or import on-disk ISO images to dramatically speed
up and virtually automate target file-system image creation.

Importing ISO Images

Normally when bulding a target file-system image the user is prompted to insert various
optical media discs containing the software that is required in order to create the initial
target file-system image. If only one or two images are being produced, manually inserting
optical media is generally acceptable.

However, if the user is generating and maintaining several different target file-system
image configurations, it is often preferable to create on-disk ISO images of the various
optical media discs. To accomplish this, select the Import ISO Images item in the
Tools menu, or click the Import ISO Images button on the Build Image page,
and the following dialog will appear.

ages ()

Importing 1SO images allows Architect to build target system images very quickly,
| ;/. without prompting for DVDs or CDs. 1SO images may be imported (ripped) from DVDs
4 or CDs, or existing IS0 image files on your hard disk may be used.

R

~Import Method

() Copy existing file(s) () Symlink to existing file(s)

Release: [RedHawk 5.4 |+

Red Hat Enterprise Linux (5.4) | Import | | Delete |
RHEL 5.4 Updates (5.4) | import || Delete |
RedHawk Linux OS (5.4) | Import | | Delete |
NightStar RT (4.1-5R4 or newer) | Import | | Delete |
Imported 1SO directory: jvarflib/architect/ISOs |M|
oK

Figure 2-1 Import ISO Images Dialog

There are three different methods that can be used to import ISO images:
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¢ Import ISO images directly from manually inserted optical media
¢ Copy ISO images from already existing ISO image files
¢ Link ISO images to already existing ISO images files

These various methods will be described in the following sections.

The user can import different sets of ISO images for different RedHawk release versions;
use the Release pull-down menu to select which version of RedHawk to import ISO
images for.

In addition, different import methods can be used within a specific RedHawk release. For
example, it is possible to use one import method to import the Red Hat ISO images and a
different import method to import the RedHawk and NightStar ISO images. All
combinations are valid.

Importing ISO Images From Optical Media

2-2

To use this method select the Rip from DVD or CD import method and then press
the IMpPOTrt button to begin the import process. A dialog similar to the following dialog
will be displayed.

Rip ISO Images From Media [x]

Ripping ISO images from media.

—Current Progress

Ripping 150(s) for RedHawk Linux 05 (5.4):

2 Rip IS0 Images From Media Prompt.  [X

\i{} Please insert the RedHawk Linux OS (Version 5.4) CD.

~Overall Progress

View: | Status EJ

Ripping 150(s) for RedHawk Linux 05 (5.4)

Abort | |

e

Figure 2-2 Rip ISO Images From Media

At this point the correct optical media disc for the requested item should be manually
inserted into the host system’s optical media tray. Once the optical media has been
inserted, press OK to begin copying the ISO image from the optical media onto the host
system’s hard-drive. Various status messages will be displayed as the copy progresses.
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Copying ISO Images From Existing 1ISO Images

To use this method select the Copy existing file(s) import method and then press
the IMport button to begin the import process. A file selection dialog similar to the
following dialog will be displayed.

Look in: | 7 thomejason - © 0 @ @ B
& computer bin
PRty data
= jason doc
P architect emacs
¥ images
media
net
source
web

File name: “ | | Open
Files of type: |1S0s (*.iso) |+ | Cancel
4

Figure 2-3 Copy ISO Image File Selector

Navigate the file selection dialog to the appropriate directory, select the ISO image and
then press the Open button. This will begin the process of copying the ISO image file
into Architect’s /var/lib/architect/ISOs directory. Once the copy is completed,
the ISO image file that was copied is no longer needed and can be removed if necessary.

Linking To Existing ISO Images

To use this method select the Symlink to existing files(s) import method and then
press the IMPOTT button to begin the import process. A file selection dialog similar to the
following dialog will be displayed.
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Look in: | B9 fhomefjason ]G © O & @ E
B computer bin
i data
= jason doc
P architect emacs
images
media
net
source
web

File name: || | | Open
Files of type: | 1S0s (*.iso) |~ | Cancel
A

Figure 2-4 Symlink To ISO Image File Selector

Navigate the file selection dialog to the appropriate directory, select the ISO image and
then press the Open button. This will immediately create a symbolic link to the selected
ISO image file. The symbolic link will be created and placed inside Architect’s
/var/lib/architect/ISOs directory. Once the copy is completed, the ISO image
file that was linked to must be preserved and kept at the exact same file-system location in
order for Architect’s symbolic link to be valid.

NOTE
Architect will detect if it has symbolic links to ISO image files
that have been erroneously removed and ISO image will no longer
be shown as a valid ISO image in the list of imported ISO images.
If this happens, the ISO image must be imported again to be valid,

otherwise Architect will prompt for the corresponding optical
media disc during any subsequent target file-system image builds.

Deleting Imported ISO Images

Previously imported ISO images can be deleted at any time by pressing the Delete
button of the corresponding ISO image. This is not generally necessary, but can be done in
order to save disk space or to recover from the rare case of a file corruption.
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